


Help Topics for Softerm Modular

Important: The READ.ME file on the Install diskette contains important information about changes and
additions which have been made since the Softerm Modular manual was printed.

Session Manager

General Information
Stop Session

Exit Session

Quick Start

Session Manager Window
Session Profile

Synopsis of Softerm Profiles
Configuration Data Base
Customer Service

Modes of Operation
Softerm Status Line

Session Manager Menus

File Menu
The File Menu lets you create and load different Configuration files and Exit Softerm Modular.

Session Menu
The Session Menu supplies the tools to create, change and delete all profiles, and to start and stop
Session profiles.

Options Menu
The Options Menu provides control of the Session Manager window and the special Show All

installation mode.
Softerm Profiles

Add Session Profile
Auto-Start (Session Profile)

Note: The profiles marked with an e are Compound profiles. The Simple profiles are reached
through their associated Compound profiles.

e Connection Path Profile
Connection Path Settings

Modem Profile
Modem Settings

e Terminal Emulation Profile

Terminal Emulation Settings
Duplex [Echo] Setting

Printer Definitions

Keyboard Profile

Remap Keyboard
Find Character / Function



e File Transfer Profile

Ind$File File Transfer Protocol Settings

Protocol Converter Profile Module

e Script File Profile
Script Variables

e System Environment Profile

System Environment Settings
Colors

Default Path
Exit Action Options
Edit Action Options

Nationality Profile

Nationality Settings
Select Predefined Translations

Print Path Profile
Print Path Settings

e Telephone Network Profile
Telephone Network Settings

Admittance Data

Admittance Data
Phone Number
Manual Connect Mode

Session (Runtime) Window

General Information
Exit

Session Window Menus

File Menu
File Menu options include File Transfer; Data Capture; Connect / Disconnect; and the Scrollback
Buffer.

Edit Menu
The Edit Menu lets you Mark and Copy Terminal Emulation data and Paste to Terminal Emulation..

Options Menu
Options Menu options include defining and using Keyboard Playback IDs (macros) and performing

Terminal Functions.

Settings Menu
The Settings Menu lets you change (and save) operation settings "on-the-fly."



Help for Install Disk Path

In the Source Path field, please provide the path (drive and directory) where Softerm can locate the files
necessary for installation.



Source Path

Type the path (disk drive and directory) where source files can be found. This can be a directory on a
local hard drive, if you copied all the files from the distribution disks; a floppy disk drive, if you will use
your distribution disks; or a network drive.



Help for Install Disk Path

Softerm was unable to locate the necessary files in the specified drive and directory. Please correct the
Source Path information or cancel.



Source Path

Type the path (disk drive and directory) where source files can be found. This can be a directory on a
local hard drive, if you copied all the files from the distribution disks; a floppy disk drive, if you will use
your distribution disks; or a network drive.



Help for Keyboard Profile

This is an optional profile. You will not need to make a special Keyboard profile if the following are true:

1. You are using a 101-key keyboard,
2. You do not need to remap any keys, and
3. You will not assign Record Mode keyboard macros to a key.

The Keyboard profile provides almost total control over the keyboard by changing key assignments
(mappings). Keys can be mapped to output:

A different character
A string of characters
A function

A combination of all

Note: Keyboard Record Mode Playback IDs are treated as functions. Use the Keyboard profile to map
a key to a Playback ID.

Important: A Keyboard profile is linked to a Terminal Emulation profile and passes its characters to the
emulation. The emulation then is responsible for how the characters are passed to the display and to the
host.

Add
Use to create a new Keyboard profile and add it to the configuration data base file.

Change Profile
Choose the existing profile you wish to modify or examine and select Change.

Delete Profile
Choose the existing profile you wish to remove from the configuration file and select Delete.

Close
Return to the point from which you accessed this dialog.



List of Keyboard Profiles

The list box shows the names of all Keyboard profiles which are present in the configuration data base
file.

Select Add to create a Keyboard profile. To examine or modify a profile, choose it and select Change.
To remove a profile from the configuration data base file, choose it and select Delete.



Add Keyboard Profile

Create a profile and add it to the configuration data base file.



Change Keyboard Profile

Choose the existing profile you wish to modify or examine and select Change.



Delete Keyboard Profile

Choose the profile you wish to remove from the configuration file and select Delete.



Help for Add Keyboard

Complete this dialog to define the physical layout of your keyboard, the terminal emulation which will use
this keyboard definition, and the default nationality of your keyboard.

For more information, select:

Keyboard Layout
Terminal Keyboard Type
Nationalit



Keyboard Layout

Choose from the list of keyboard types the one which most closely matches the keyboard you are using,
such as 101-Key Enhanced.



Terminal Keyboard Type

Choose the terminal emulation to which this Keyboard profile will be linked. This list shows installed
terminal emulations. If only one emulation has been installed, only that one will appear on this list.

Note: This parameter ensures that a key mapping for one terminal emulation is not attached
accidentally to an incompatible terminal emulation.



Nationality

Choose the nationality which best describes the default nationality and physical key mapping of your
keyboard.



Help for Keyboard Profile Settings

Complete the Keyboard Profile Settings dialog to create a complete description of a keyboard mapping
which can be linked to a Terminal Emulation profile.

To make changes to a Keyboard setting, choose the applicable string from the list box and select Change.

When you are finished, you can select Save or Save As to retain the settings or select Cancel to exit the
dialog without taking action.

Note: Save As is a good choice when major changes have been made to a working profile. The
changes can be tested without replacing the working version.



Comment

Type any desired remarks in this optional, 64-character field.



List of Keyboard Profile Settings

The setting strings applicable to the current keyboard are displayed. To examine or modify any settings,
choose the applicable string and select Change.



Change

Choose the setting you wish to examine or modify and select Change.



Save

Select this button to save any changes you have made to the profile's present name. Select Save As to
make a new profile.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Help for Save Keyboard Profile
Type a name for this profile to complete this dialog.
Select Save to add this profile to the configuration data base file.

Select Cancel to exit the dialog without taking any action. All changes will be lost.



Name for Keyboard Profile

Type a name which means something to you. The name can use a maximum of 20 characters, including
spaces.



Save

Save the profile to the configuration data base file.



Help for Delete Keyboard Profile
If the Keyboard profile you have selected to delete is linked to any Session profiles, they will be listed.

Deleting the Keyboard profile may cause the affected Session profiles to experience difficulties, unless a
new Keyboard profile is added in its place.



Sessions Using Profile
This list displays all Session profiles which use this Keyboard profile.

Deleting the Keyboard profile may cause the affected Session profiles to experience difficulties, unless a
new Keyboard profile is added in its place.



Delete Profile

Delete the profile from the configuration data base and exit this dialog.



Do Not Delete Profile

Stop the delete sequence. Exit this dialog without taking any action.



Help for Softerm Session Manager

Important: Help is available at all times. Select the Help pushbutton for general information about the
dialog, or press F1 when the focus is on any field or pushbutton.

Note: Alist of additional Help topics is at the end of this Help panel.
Softerm Session Manager

The Session Manager provides the tools to manage (create, change and delete) component profiles and
assemble them to form Session profiles.

Session profiles contain all the information to successfully complete an end-to-end communications
session.

One or more Session profiles can be set to activate automatically when Softerm is started.

Important: The maximum number of active sessions is 32. Your system hardware may limit the
number which can be active at the same time.

Connect to Another System

To call (connect to) another computer system, start the appropriate Session profile. When a connection
is established, the Session Manager transfers control to a Session Window. This window also is called
a Runtime Window, a Terminal Emulation Window or the Online Window.

For more information, select:

Quick Start

What Will Softerm Do

Change (or Examine) Session Profiles
Add (Create) Session Profiles

Session Manager Window - Description
Session Manager Menus - Synopsis
Modes of Operation

What is the Session Manager

Synopsis of Softerm Profiles

What Are Softerm Modules

Configuration (Profile) Data Base
Additional Modules

Profiles - Description and Definition
Customer Service

Definitions

What is Softerm Modular



Session Menu
Use the Session Manager's Session menu to:

Start a new communications connection in a new Session Window
Stop a running Session Window

Manage (add/change/delete) Session profiles

Setup (manage) component profiles

Important: The maximum number of active sessions is 32. Your system hardware may limit the
number which can be active at the same time.



Start Session

Select this Session menu option to activate the Session profile whose name is highlighted. You also can
choose a Session profile name and press Enter, or click on the profile name.

Important: The maximum number of active sessions is 32. Your system hardware may limit the
number which can be active at the same time.



Stop Session

When you select Stop from the Session Menu, a list of all active sessions is displayed. You can stop one
or more Sessions. When a Session is stopped, all its resources are cleared from memory and any active
connections are terminated.



Exit Session

Use the File menu's Exit option or the System icon's Close option to quit Softerm, no matter how many
Sessions are active. All active connections are broken and all resources are cleared from memory.

Important: If any Session Windows are active and the program detects that changes have been made
to any profiles used by the window, you will be able to save the changes before exiting.



Help for File Menu
Use the File menu to

Make an entirely-new configuration file

Make a new configuration file using the current file as the base
Load a different configuration file

Exit Softerm Modular, closing all Session Windows

Important: Under the OS/2 and Windows operating systems, active (runtime) sessions are processes
separate from the manager which started them. Thus, replacing the current configuration file and
Session Manager with a new one will not terminate any active sessions.



Add Configuration

This option is intended to assemble a new Session profile using existing component profiles. If a field is

empty, no component profile has been created. However, component profiles can be created and
modified from this menu.

Note: A Session profile generally consists of Terminal Emulation, Connection Path and System
Environment profiles, but there are exceptions.

Important: If a profile field is greyed, the module has not been installed. Additional modules are
available from Softronics, Inc.



Change Configuration

Use to examine or modify a Session profile. Choose the appropriate profile and select this option.



Delete Configuration

Use to remove a Session profile from the display and the configuration file. Choose the profile you wish
to remove and select this option.



New (Configuration File)

Use to make an entirely-new configuration file. (If you want to use an existing file as the starting point,
make sure it is the active configuration and use the Save As option.)



Open (Configuration File)
Use to load a different, existing configuration file.
Important: Under the OS/2 and Windows operating systems, active (runtime) sessions are processes

separate from the manager which started them. Thus, replacing the current configuration file and
Session Manager with a new one will not terminate any active sessions.



Save As

Make a new configuration file based on the current one.



Exit Session

Use the File menu's Exit option or the System icon's Close option to quit Softerm, no matter how many
Sessions are active. All active connections are broken and all resources are cleared from memory.

Important: If any Session Windows are active and the program detects that changes have been made
to any profiles used by the window, you will be able to save the changes before exiting.



Options Menu
The Options menu provides access to these Session Manager functions:

1. Saving the parameters being used by the Session Manager Window

2. Setting whether the Session Manager window should minimize to an icon as soon as a Session
Profile is activated

3. Turning on and off the special Show All option



Setup Profiles

This Session Manager Session Menu option is designed to quickly create, change, examine and delete
multiple profiles.

When this option is chosen, a dialog presents a list of all installed compound Profile Managers (such as
Terminal Emulation, Keyboard, Print Path). Note that each simple Profile Manager is accessed through
its parent Profile Manager.

Select the button of a Profile Module name to modify or examine an existing profile or create new profiles.

Important: If a profile name is greyed, the module has not been installed. Additional modules are
available from Softronics, Inc.



Save Window

Use to save the current position and size, and the setting of the Minimize On Use option of the Session
Manager window.



Minimize on Use

If this option is checked, the Session Manager window will minimize to an icon as soon as a Session
profile is started. To make this the default, select the Save Window option to update the data base.



Show All

When creating profiles, setting this option makes available all the resources on the Softerm distribution
disks, rather than only the resources which already have been installed. Prompts will request that the
applicable disk be placed in the disk drive you designate.

For more information, select:

Show All - On



Help

Use these choices to find out how to use help, to get general help, to go to a list of keys, to go to the help
index, or to view product and copyright information.

General help
Descriptions of the Softerm Session Manager and profiles.

Keys help
Displays a list of keys.

Help index
Displays the help index.

Product information
Displays product and copyright information.



Keys Help
For information, select one of these topics:

Cursor movement keys
Action bar keys

Menu keys

Dialog keys

System keys



Help for Softerm Session Manager

Important: Help is available at all times. Select the Help pushbutton for general information about the
dialog, or press F1 when the focus is on any field or pushbutton.

Note: Alist of additional Help topics is at the end of this Help panel.
Softerm Session Manager

The Session Manager provides the tools to manage (create, change and delete) component profiles and
assemble them to form Session profiles.

Session profiles contain all the information to successfully complete an end-to-end communications
session.

One or more Session profiles can be set to activate automatically when Softerm is started.

Important: The maximum number of active sessions is 32. Your system hardware may limit the
number which can be active at the same time.

Connect to Another System

To call (connect to) another computer system, start the appropriate Session profile. When a connection
is established, the Session Manager transfers control to a Session Window. This window also is called
a Runtime Window, a Terminal Emulation Window or the Online Window.

For more information, select:

Quick Start

What Will Softerm Do

Change (or Examine) Session Profiles
Add (Create) Session Profiles

Session Manager Window - Description
Session Manager Menus - Synopsis
Modes of Operation

What is the Session Manager

Synopsis of Softerm Profiles

What Are Softerm Modules

Configuration (Profile) Data Base
Additional Modules

Profiles - Description and Definition
Customer Service

Definitions

What is Softerm Modular



Help for Product Information

Use this choice to display the copyright and product information.



OK

Select OK to accept the dialog and continue.



Cancel

Exit this dialog without taking any action.



Configuration File Name

Type the name for the configuration data base file.



Drive

If not entered into the name field, use this field to choose the desired disk drive.



Directory

If not entered into the name field, use this field to choose the desired directory.



File

If not entered into the name field, use this field to choose the desired file name.



Help for Save As

Use this dialog to make a new configuration file based on the current one. Remember that when the new
configuration is activated, a backup also is made.

Enter a new path and file name to use. When the new file is created, it becomes the active configuration
file, and session and profile changes will affect it.



Help for New Configuration File

Important: Under the OS/2 and Windows operating systems, active (runtime) sessions are processes
separate from the manager which started them. Thus, replacing the current configuration file and
Session Manager with a new one will not terminate any active sessions.

Use this dialog to make an entirely-new configuration file. (If you want to use an existing file as the
starting point, make sure it is the active configuration and use the Save As option.) Remember that when
a new configuration file is activated, a backup also is made.

Specify a path and a file name. The file can be created in any valid path.

When you select the OK pushbutton, Softerm creates the file and writes the basic information which is
required by all configuration files. At the finish of this process, which may require a couple minutes, you
will return to a blank Session Manager window. In a LAN environment, if this is a shared file, other users
will be locked out until the process is complete. Use the Session menu to create component and
Session profiles.



Help for Open File

Important: Under the OS/2 and Windows operating systems, active (runtime) sessions are processes
separate from the manager which started them. Thus, replacing the current configuration file and
Session Manager with a new one will not terminate any active sessions.

Use this dialog to load a different, existing configuration file.
Provide a path and a file name. (If necessary, use the File and Directory list boxes.) Select OK when

the displayed information is correct. If the file is not a valid configuration file, Softerm prompts you to
choose a different file.



OK

Select this button to save all Session Manager profiles to the indicated file name and directory.



Help for Stop Session

This dialog displays a list of all active sessions. One or more Sessions can be stopped. When a
Session is stopped, all its resources are cleared from memory and any active connections are terminated.

Select Stop to stop the highlighted Session.

Select Cancel to exit this dialog without taking any action.



List of Active Sessions

This list displays the names of all active Sessions. To stop a Session, choose the name and select Stop.



Stop

Stop the selected Session and its connection (if it is active). Clear the Session's resources from the
computer's memory.



Help for Exit Session

Quit Softerm, no matter how many Sessions are active. All active connections are broken and all
resources are cleared from memory.

Important: If any Session Windows are active and the program detects that changes have been made
to any profiles used by the window, you can save the changes before exiting by checking the Save
Settings box.



Save Settings

Changes have been made to one or more profiles. Check this option box if you want to save the
changes before exiting.



Exit

Deactivate all Session Windows and exit Softerm.



Do Not Exit

Exit this dialog without taking any action. Return to the Session Manager.



Help for Show All - On

Selecting Show All makes available all the resources on the Softerm distribution disks, rather than only
those which already have been installed. This function remains active until turned off or until you exit
Softerm.

Important: Two installation data base files are required. If they are not available in Softerm's directory,
Softerm will attempt to copy them from the Source Path as soon as you select the Show All pushbutton.

When you create and change profiles, the list of available resources normally shows only those which
already are installed. With the Show All option turned on, the list will show all the supplied resources.
When a resource, such as a terminal emulation, is chosen and is not already installed, Softerm will install
it from the drive and directory you specify here.

All necessary files will be copied to the local disk and the active configuration data base file will be
updated.

Note: If the resource is not found in the specified path, Softerm will prompt you to provide a new path.



Source Path

Type the path (disk drive and directory) where source files can be found. This can be a directory on a
local hard drive, if you copied all the files from the distribution disks; a floppy disk drive, if you will use
your distribution disks; or a network drive.

Note: Softerm will have to copy two data base files which contain information about available resources
and their location. When Show All is turned off or when you exit Softerm, these files automatically will be
deleted.



Help for Show All - Off
Selecting Show All-Off restricts resources to those which already have been installed.
For more information, select:

Show All



Show All

Select this button to initiate the Show All mode.



Show All-Off

Select this button to turn off the Show All mode.



Help for Script File Profile

Important: Script files must be profiled so that they can be started from the Session Window.

Script Files are similar to Batch and Command files in that they automate repetitive tasks. A Script File
profile may contain only the name of a Script File or it can pre-set up to five variables which are used in
the Script File. A Script File can be designated as Auto-Start and can be activated automatically when a
Session profile starts.

Please refer to the Session Manager: Introduction and Script File chapters.

Add
Use to create a new Script File profile and add it to the configuration data base file.

Change Profile
Choose the existing profile you wish to modify or examine and select Change.

Delete Profile
Choose the existing profile you wish to remove from the configuration file and select Delete.

Close
Return to the point from which you accessed this dialog.



List of Script File Profiles

The list box shows the names of all Script File profiles which are present in the configuration data base
file.

Select Add to create a Script File profile. To examine or modify a profile, choose it and select Change.
To remove a profile from the configuration data base file, choose it and select Delete.



Add Script File Profile

Create a profile and add it to the configuration data base file.



Change Script File Profile

Choose the existing profile you wish to modify or examine and select Change.



Delete Script File Profile

Choose the profile you wish to remove from the configuration file and select Delete.



Help for Add Script File

Use this dialog to select the specific existing Script File to profile.

Enter the path (if necessary) and file name in the Script File Name field (80 characters maximum), or use
the Drive, File and Directory lists to locate the Script File. Notice that the Directory list defaults to

displaying file names having the .SCR extension.

When the information displayed is correct, select Add.



Script File Name

Enter the path (if necessary) and file name in this 80-character field, or use the Drive, File and Directory
lists to locate the Script File. Notice that the Directory list defaults to displaying file names having

the .SCR extension.

When the information displayed is correct, select Add.



Drive

If you do not know the exact path and filename, use the Drive, Files and Directory options to locate and
select the Script File you wish to profile.



File

If you do not know the exact path and filename, use the Drive, Files and Directory options to locate and
select the Script File you wish to profile.



Directory

If you do not know the exact path and filename, use the Drive, Files and Directory options to locate and
select the Script File you wish to profile.



Help for Script File Settings
To make changes to a Script File variable setting, select Change.

When you are finished, you can select Save or Save As to retain the settings or select Cancel to exit the
dialog without taking action.

Note: Save As is a good choice when major changes have been made to a working profile. The
changes can be tested without replacing the working version.



Comment

Place any explanatory remarks in this optional, 64-character field.



List of Script File Settings

The only settings applicable to the Script profile are the variables. To examine or modify any variables,
select Change.



Help for Script Variables
Use this dialog to pre-set up to five variables which are in the Script File being profiled.

For additional information, please refer to the Script Files chapter.



Script Variables 1-5

These correspond to the Script Variables covered in the Script Files chapter. That is, Script Variable 2
corresponds to SV2 in the Script File.

If the Script File being profiled uses no Script variables, or if they are set from within the Script, leave
these fields blank.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Help for Save Script
Type a name for this profile to complete this dialog.
Select Save to add this profile to the configuration data base file.

Select Cancel to exit the dialog without taking any action. All changes will be lost.



Save

Save the profile to the configuration data base file.



Name

Type a name which means something to you. The name can use a maximum of 20 characters, including
spaces.



Help for Delete Script Profile
If the Script profile you have selected to delete is linked to any Session profiles, they will be listed.

Deleting the Script profile may cause an affected Session profile to experience difficulties, unless a new
Script profile is added in its place or the Session profile is changed so that it does not have an auto-start
Script.



Sessions Using This Profile
This list displays all Session profiles which use this Script profile.
Deleting the Script profile may cause an affected Session profile to experience difficulties, unless a new

Script profile is added in its place or the Session profile is changed so that it does not have an auto-start
Script.



Delete Profile

Delete the profile from the configuration data base and exit this dialog.



Do Not Delete Profile

Stop the delete sequence and exit this dialog without taking any action.



Help for System Environment Profile

This is an optional profile. A System Environment profile maintains system-wide parameters for a
Session profile by assembling Nationality and Print Path profiles, and setting a Default Directory, Exit
Action options, Edit Action options and Colors.

Important: This is a particularly powerful and useful profile. For example, even though only 25
Keyboard Playback files can exist in a directory, each Session profile can be assigned a different Default
Path to a directory which contains its own set of Keyboard Playback files. The Default Path setting also
affects the default directory used for file transfer operations and files created automatically when a "disk"
printer is used.

Using a different Color combination for each Session gives you a handy visual reference which identifies
which Session Window you are working with. This is especially useful if you have several Sessions
active at the same time.

In an international communications environment, the Nationality profile will customize the communications
display for each task.

Providing a System Environment profile for each Session helps to eliminate confusion.

Add
Use to create a new System Environment profile and add it to the configuration data base file.

Change Profile
Choose the existing profile you wish to modify or examine and select Change.

Delete Profile
Choose the existing profile you wish to remove from the configuration file and select Delete.

Close
Return to the point from which you accessed this dialog.



List of System Environment Profiles

The list box shows the names of all System Environment profiles which are present in the configuration
data base file.

Select Add to create a System Environment profile. To examine or modify a profile, choose it and select
Change. To remove a profile from the configuration data base file, choose it and select Delete.



Add System Environment Profile

Create a profile and add it to the configuration data base file.



Change System Environment Profile

Choose the existing profile you wish to modify or examine and select Change.



Delete System Environment Profile

Choose the profile you wish to remove from the configuration file and select Delete.



Help for System Environment Settings

A System Environment profile maintains system-wide parameters for a Session profile by assembling
Nationality and Print Path profiles, and setting a Default Directory, Exit Action options, Edit Action options
and Colors.

Important: This is a particularly powerful and useful profile. For example, even though only 25
Keyboard Playback files can exist in a directory, each Session profile can be assigned a different Default
Path to a directory which contains its own set of Keyboard Playback files. The Default Path setting also
affects the default directory used for file transfer operations and files created automatically when a "disk"
printer is used.

Using a different Color combination for each Session gives you a handy visual reference which identifies
which Session Window you are working with. This is especially useful if you have several Sessions
active at the same time.

In an international communications environment, the Nationality profile will customize the communications
display for each task.

Providing a System Environment profile for each Session helps to eliminate confusion.

To make changes to a System Environment setting, choose the applicable string from the list box and
select Change.

For additional information, select:

Nationality Profiles
Print Path Profiles

Default Path
Colors

Exit Action options
Edit Action options

When you are finished, you can select Save or Save As to retain the settings or select Cancel to exit the
dialog without taking action.

Note: Save As is a good choice when major changes have been made to a working profile. The
changes can be tested without replacing the working version.



Comment

Place any explanatory remarks in this optional, 64-character field.



List of Nationality Profiles
This is an optional entry. In many cases, no Nationality profile will be required.

This drop-down list displays all existing Nationality profiles. If one is required, choose it, or select Setup
to examine, change or create one.



Setup Nationality Profile

Select this button to examine, change or create a Nationality profile.



List of Print Path Profiles
This is an optional entry. However, it generally is useful to link a predefined print device to a Session.

This drop-down list displays all existing Print Path profiles. If one is required, choose it, or select Setup
to examine, change or create one.



Setup Print Path

Select this button to examine, change or create a Print Path profile.



List of System Environment Settings

The settings applicable to the System Environment are displayed. To examine or modify any settings,
choose the applicable setting and select Change.



Change

Choose the setting you wish to examine or modify and select this button.



Save with Current Name

Select this button to save any changes you have made to the profile's present name. Select Save As to
make a new profile.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Help for Save System Environment Profile
Type a name for this profile to complete this dialog.
Select Save to add this profile to the configuration data base file.

Select Cancel to exit the dialog without taking any action. All changes will be lost.



System Environment Profile Name

Type a name which means something to you. The name can use a maximum of 20 characters, including
spaces.



Save

Save the profile to the configuration data base file.



Delete System Environment Profile

If the System Environment profile you have selected to delete is linked to any Session profiles, they will
be listed.

Deleting the System Environment profile probably will cause the affected Session profiles to experience
difficulties, unless a new System Environment profile is added in its place.



Sessions Using This Profile
This list displays all Session profiles which use this System Environment profile.

Deleting the System Environment profile probably will cause the affected Session profiles to experience
difficulties, unless a new System Environment profile is added in its place.



Delete Profile

Delete the profile from the configuration data base and exit this dialog.



Do Not Delete Profile

Stop the delete sequence and exit this dialog without taking any action.



Default Path

Type the complete default path, such as:

S:\SOFTERM\USER\RIK

You also can use the Drive and Directory list to choose the Default Path.



Drive

If necessary, use this list to choose the drive.



Directory

If necessary, use this list to choose the directory.



List of Code Pages

The drop-down list shows all supports Code Pages. Choose the most appropriate for your application.



Help for Set Video Code Page

The Video Code Page determines the appearance of the characters displayed in the Client Area (Terminal
Emulation screen) by outgoing and received data and by messages displayed by Script file functions.

Although most are identical (for example, 041 hex always displays an "A"), many of the upper ASCII
range (80 - FF Hex) produce different characters. For example, 09B hex produces the dollar ($)
currency symbol using the United States Code Page (437), but a lower-case stroked "0" using the
Multinational Code Page (850).

Important: The Video Code Page does not affect characters transmitted between the host system and
the terminal emulation. Such character translation is handled by the active Nationality profile.



Set

Accept (set) the displayed Video Code Page.



Help for Default Path

If you plan to perform several operations in a particular directory, setting the Default Directory is a good
way to avoid having to enter complete path names each time you want to access files.

The Default Path affects Keyboard Playback ID files, file transfer operations, and printing.

Each active Session can have its own Default Path.



OK

Select OK to accept the dialog and continue.



Add

Select Add to accept the information and, after providing a name, add it to the configuration data base file.



Cancel

Select this button to exit this dialog without taking any action.



Help for Setup Profiles

This dialog presents all the Compound profile modules which are installed. Select the appropriate Profile
Module name button to transfer to that profile's manager so you can modify or examine an existing profile
or create new profiles. Note that Simple profile modules are accessed through the related Compound

profile manager.

When you are finished, select Cancel or Close to return to the point from which you accessed this dialog.



Select Profile Modules

Select the appropriate Profile Module name button to modify or examine an existing profile or create new
profiles.



Setup Profile

When you select Setup, the manager for the marked profile is activated. You can create, examine,
change and delete profiles.



Save with Current Name

Select this button to save any changes you have made to the profile's present name. Select Save As to
make a new profile.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Help for Options Menu
This dialog lets you set the Start Session and Auto Start parameters for this Session profile.

The Start Session parameter determines the initial size of the Session Window. Auto Start determines if
this Session profile will be activated automatically when Softerm starts. Multiple sessions can be
designated as Auto-Start.

For additional information, select:

Auto-Start (Session Profile)
Start Session Options



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Save with Current Name

Select this button to save any changes you have made to the profile's present name. Select Save As to
make a new profile.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Save with Current Name

Select this button to save any changes you have made to the profile's present name. Select Save As to
make a new profile.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Profile Already Exists
You already have used this name for an existing profile.
Select:

Replace
To replace the existing profile with the new one.

Cancel
To provide a different name.



Save

Save any changes you have made to the profile.



Close

Select Close to leave this dialog and continue.



Help for Add / Change Session Profile

This dialog is intended to be used to create or modify a Session profile using existing component
profiles. An empty field indicates that the current configuration data base file does not contain that type
of component profile.

Use the drop-down list boxes to choose the component profiles to be assigned to this Session profile.

Setup Profiles Button
If you need to create or modify a component profile, select the Setup profiles button and then the
appropriate named component profile button in the next dialog.

Note: A Session profile generally requires, as a minimum, Terminal Emulation, Connection Path and
System Environment profiles, but there are exceptions.

Options Button
Select the Options button to set the Auto-Start and default window parameters for the Session profile.

Add / OK Button
When the necessary profiles are assembled and displayed, select Add / OK to save the Session profile.
You will be able to save the profile to a new Session name, or current name, if performing a Change.



Comment

Type any explanatory remarks in this optional, 64-character field.



Terminal Emulation Profiles
Use the drop down list to choose the Terminal Emulation profile to be used by this Session profile.

If the required profile is not available or if you need to examine a profile's settings, select the Setup
profiles button.

Note: If you do not select a Terminal Emulation profile for the Session, "[None]", the Session must
have a Auto-Start script define. A Session must define a Connection Path profile and ether a Terminal
Emulation profile or an Auto-Start Script profile.



Options

Select this button to set the default window and Auto Start parameters for this Session profile.



Connection Path Profiles
Use the drop down list to choose the Connection Path profile to be used by this Session profile.

If the required profile is not available or if you need to examine a profile's settings, select the Setup
profiles button.

Note: A Session must define a Connection Path profile and ether a Terminal Emulation profile or an
Auto-Start Script profile.



Setup Profiles

Select this button to transfer to the Setup Profiles dialog to examine, create, modify or delete profiles.



System Environment Profiles
Use the drop down list to choose the System Environment profile to be used by this Session profile.

If the required profile is not available or if you need to examine a profile's settings, select the Setup
profiles button.

Note: If you do not select a System Environment Profile for the Session, "[None]" for the System
Environment Profile, Softerm to will use the following default Environment:

Nationality None - English

Print Path Disk Printer using Temp Files
Colors Default Colors

Default Path  Softerm Modular Directory
Exit Action Prompt if changes made

Edit Action Copy to Clipboard, No formatting



Setup System Environment

Select Setup to transfer to the System Environment Module to examine, create, modify or delete profiles.



File Transfer Profiles
Use the drop down list to choose the File Transfer profile to be used by this Session profile.

If the required profile is not available or if you need to examine a profile's settings, select the Setup
profiles button.

Note: Selecting a File Transfer Profile for the Session is needed for Drag and Drop functionality.
Otherwise, Drag and Drop will use the Character Protocol.



Auto-Start Script Profiles

Use the drop down list to choose a Script profile which will start automatically when this Session starts.

If the required profile is not available or if you need to examine a profile's settings, select the Setup
profiles button.



Auto-Start (Session Profile)

If this box is checked, this Session profile will be activated automatically when Softerm starts. Multiple
sessions can be designated as Auto-Start, and each will activate when Softerm starts (depending, of
course, on the physical resources available to the personal computer).

Important: The maximum number of active sessions is 32. Your system hardware may limit the
number which can be active at the same time.

Note: You can also Auto-Start a Session profile when you Start Softerm Modular, by entering the
Session profile name within " " followed by switch /P.

Example: SOFTERM.EXE SOFTERM.MDB "MY SESSION"/P

Also, to Auto-Start a Session profile and bypass the Session Manager, going directly to the Session
Window, add the /R switch before the Profile Name.

Example: SOFTERM.EXE /R SOFTERM.MDB "MY SESSION"/P

For more information, please see Appendix E, Softerm Modular switches in the Manual.



Start Session Options
This option determines the initial size of the Session Window.

Start Minimized
This Session will be minimized to an icon when it starts.

Start Windowed
This Session will be the size of a normal window when it starts. This is the default setting.

Start Maximized
When started, this Session will use a window approximately 80 columns wide and 25 rows deep.



Add Session Profile

Select this button to add this Session profile to the current configuration data base file. You will be
prompted to provide a name.



Help for Save Session Profile
Type a name for this profile to complete this dialog.
Select Save to add this profile to the configuration data base file.

Select Cancel to exit the dialog without taking any action. All changes will be lost.



Name for Session Profile

Type a name which means something to you. The name can use a maximum of 20 characters, including
spaces.



Save

Save the profile to the configuration data base file.



OK - Change Session Profile

Select this button to update changes to this Session profile to the current configuration data base file.
You will be given the option to save under another name (Save as).



Help For Delete Session Profile
Delete will remove the highlighted Session Profile from the Data base.

Note: Deleteing a Session Profile will not effect any of it's sub-profiles. Only the Session Profie with its
Saved Windowed information and Addmentance data will be deleted from the data base.



Delete
Select Delete push button to remove the highlighted Session Profile from the data base.

Note: Deleteing a Session Profile will not effect any of it's sub-profiles. Only the Session Profie with its
Saved Windowed information and Addmentance data will be deleted from the data base.



Do Not Delete
Select Do Not Delete push button to cancel the delete operation and return without any action taken.

Note: Deleteing a Session Profile will not effect any of it's sub-profiles. Only the Session Profie with its
Saved Windowed information and Addmentance data will be deleted from the data base.



Help for Telephone Network Profiles

The Telephone Network profile defines the Prefix and Suffix to be used to access a particular telephone
network, such as a PBX, and forms part of the Admittance Data.

Important: This profile is valid only when the Session profile includes a Modem profile.

Add
Use to create a new Telephone Network profile and add it to the configuration data base file.

Change Profile
Choose the existing profile you wish to modify or examine and select Change.

Delete Profile
Choose the existing profile you wish to remove from the configuration file and select Delete.

Close
Return to the point from which you accessed this dialog.



List of Telephone Network Profiles

The list box shows the names of all Telephone Network profiles which are present in the configuration
data base file.

Select Add to create a Telephone Network profile. To examine or modify a profile, choose it and select
Change. To remove a profile from the configuration data base file, choose it and select Delete.



Add

Create a profile and add it to the configuration data base file.



Change

Choose the existing profile you wish to modify or examine and select Change.



Delete

Choose the profile you wish to remove from the configuration data base file and select Delete.



Help for Telephone Network Settings

Complete the Telephone Network Settings dialog to define the Prefix and Suffix to be used to access a
particular telephone network, such as a PBX, and forms part of the Admittance Data.

Note: This profile is valid only when the Session profile includes a Modem profile.
To make changes, choose the applicable string from the list box and select Change.

When you are finished, you can select Save or Save As to retain the settings or select Cancel to exit the
dialog without taking action.

Note: Save As is a good choice when major changes have been made to a working profile. The
changes can be tested without replacing the working version.



Comment

Place any explanatory remarks in this optional, 64-character field.



List of Telephone Network Settings

Settings which are applicable to the Telephone Network are grouped into related sets of parameters.
Choose the parameter set you wish to modify or examine and select Change.



Change

Choose the parameter set you wish to modify or examine and select Change.



Save

Select this button to save any changes you have made to the profile's present name. Select Save As to
make a new profile.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Help for Save Telephone Network Profile
Type a name for this profile to complete this dialog.
Select Save to add this profile to the configuration data base file.

Select Cancel to exit the dialog without taking any action. All changes will be lost.



Name for Telephone Network Profile

Type a name which means something to you. The name can use a maximum of 20 characters, including
spaces.



Save

Save the profile to the configuration data base file.



Help for Delete Telephone Network Profile

If the Telephone Network profile you have selected to delete is linked to any Session profiles, they will be
listed.

Deleting the Telephone Network profile may cause the affected Session profile(s) to experience
difficulties, unless a new Telephone Network profile is added in its place.



Sessions Using Profile
This list displays all Session profiles which use this Telephone Network profile.

Deleting the Telephone Network profile may cause the affected Session profile(s) to experience
difficulties, unless a new Telephone Network profile is added in its place.



Delete Profile

Delete the profile from the configuration data base and exit this dialog.



Do Not Delete Profile

Stop the delete sequence. Exit this dialog without taking any action.



Help for Nationality Profile
This is an optional profile. In most cases, you will not need to use one.
Caution:

1. Significant problems can be created by the incorrect use of this feature.
The Nationality profile does not affect characters displayed in the Terminal Emulation user area.
The Video Code Page setting in the System Environment profile determines which characters
appear.

3. The Nationality profile only affects characters transmitted between the PC and the host systems.
It does not affect keyboard output.

Softerm is designed to operate correctly between personal computers and host systems which do not use
the United States character set.

When the host system transmits an A, we want to receive an A.  Conversely, when we send a R, we want
the host to receive and understand it as a 3. Frequently, though, the host and the personal computer
speak different languages. The Nationality profile provides the translation between the host system and
the PC.

Add
Create a new Nationality profile and add it to the configuration data base file.

Change Profile
Choose the existing profile you wish to modify or examine and select Change.

Delete Profile
Choose the existing profile you wish to remove from the configuration file and select Delete.

Close
Return to the point from which you accessed this dialog.



List of Nationality Profiles
Important: This is an optional profile. In most cases, you will not need to use one.

The list box shows the names of all Nationality profiles which are present in the configuration data base
file.

Select Add to create a Nationality profile. To examine or modify a profile, choose it and select Change.
To remove a profile from the configuration data base file, choose it and select Delete.



Add Nationality Profile

Create a profile and add it to the configuration data base file.



Change Nationality Profile

Select the existing profile you wish to modify or examine and select Change.



Delete Nationality Profile

Choose the profile you wish to remove from the configuration data base file and select Delete.



Help for Nationality Settings

This is an optional profile. In most cases, you will not need to use one.

Caution:

1. Significant problems can be created by the incorrect use of this feature. You should have a

thorough understanding of the host system's requirements before translating characters. If
character translation is necessary, the requirements may be satisfied by choosing a Predefined

Translation.

2. The Nationality profile does not affect characters displayed in the Terminal Emulation user area.
The Video Code Page setting in the System Environment profile determines which characters
appear.

3. The Nationality profile only affects characters transmitted between the PC and the host systems.

It does not affect keyboard output.

Softerm is designed to operate correctly between personal computers and host systems which do not use
the United States character set.

When the host system transmits an A, we want to receive an A.  Conversely, when we send a B, we want
the host to receive and understand it as a 3. Frequently, though, the host and the personal computer
speak different languages. The Nationality profile provides the translation between the host system and
the PC.

Complete the Nationality Settings dialog to create a complete description of a character mapping which
can be linked to a Session profile through a System Environment profile.

To make changes to a Nationality setting, choose the applicable string from the list box and select
Change.

For additional information, select:

Select Predefined Translations

Remap Incoming Data

Remap Outgoing Data
View/Delete Translations

When you are finished, you can select Save or Save As to retain the settings or select Cancel to exit the
dialog without taking action.

Note: Save As is a good choice when major changes have been made to a working profile. The
changes can be tested without replacing the working version.

Softerm Internal Values

Because a starting point is required for translation, Softerm uses the following standards for storage and
display:

. Values in the range 0 through 7F hexadecimal are stored and displayed using the United States
ASCII standard representation. For example, Softerm associates hexadecimal value 41 with the
character 'A'.

. Values in the range AO through FF hexadecimal are stored and displayed using the International
Standards Organization 8859-1 standard.

. The 32 values in the range 80 through 9F hexadecimal are reserved for internal use by Softerm.






Comment

Type any explanatory remarks in this optional, 64-character field.



List of Nationality Settings

All applicable groups of settings are displayed. To examine or modify any settings, choose the applicable
setting and select Change.

Note: We recommend that you change settings only if you are familiar with your host system's
requirements



Change Nationality Settings

Choose the setting you wish to examine or change and select Change.



Save with Current Name

Select this button to save any changes you have made to the profile's present name. Select Save As to
make a new profile.



Save As

Select this button to make a new profile. A dialog will prompt you to provide a new name.



Help for Save Nationality Profile
Type a name for this profile to complete this dialog.
Select Save to add this profile to the configuration data base file.

Select Cancel to exit the dialog without taking any action. All changes will be lost.



Nationality Profile Name

Type a name which means something to you. The name can use a maximum of 20 characters, including
spaces.



Save

Save the profile to the configuration data base file.



Help for Delete Nationality Profile
If the Nationality profile you have selected to delete is linked to any Session profiles, they will be listed.

Deleting the Nationality profile may cause the affected Session profiles to experience difficulties, unless a
new Nationality profile is added in its place.



System Environment Using Profile

This list displays all System Environment profiles which use this Nationality profile.



Delete Profile

Delete the profile from the configuration data base and exit this dialog.



Do Not Delete

Exit this dialog without taking any action.



Help for Remap Incoming Data
Use this dialog to remap a single received character to a single character.
Example:

The host system associates the value 24 hexadecimal with the character 'A’. Softerm associates that
value with the character '$'.

When the host sends value 24, we want Softerm to understand that its meaning is A.

Use the Incoming Translation drop-down list box to choose the value sent by the host system. This
might appear similar to:

24 (H) 36 (D) 44 (0)

Use the Translated Character drop-down list box to choose the character which represents the character
as Softerm should understand it. This might appear similar to:

A Upper case umlaut A C4H
Select the Translate push button when the Incoming Translation and Translated Character fields show the
correct translations. Another dialog will ask if you want to automatically map the reverse translation.
This would be the normal procedure.

Example:

Before being transmitted to the host, the value C4 hexadecimal would be translated back to the value 24
hexadecimal.

Select OK to update the translate table when you are finished making the incoming translations.

Select Cancel to exit the dialog without taking any action.



Incoming Translation Values

Use the Incoming Translation drop-down list box to choose the value sent by the host system. This
might appear similar to:

24 (H) 36 (D) 44 (0)

Note: Select the Help push button for a more detailed explanation.



Translated Character

Use th